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International Financial Services Centres Authority 
(A Statutory Authority established by Government of India) 

2nd & 3rd Floor, Savvy Pragya, Gujarat International Finance Tec-City (GIFT City), Gandhinagar, Gujarat - 382355, India. 
Corrigendum - 03 

RFP Reference No. IFSCA/Technology/2025/001 dated 09 June 2025 
 

Dated: 21 July 2025 
 
Subject: Corrigendum 03 to the RFP titled “Selection of Solution Provider for Digital Regulatory Reporting (DRR) Solution of IFSCA”. 
 
The clauses given under the column ‘Relevant Clause’ in the table below are the clauses currently present in the RFP Ref. No. IFSCA/ 
Technology/2025/001. These clauses are being replaced/ modified with the clauses mentioned under column ‘Modified/ Replaced Clause/ 
The clause to be read as’ of the table below and the RFP shall be read in accordance with the Replaced Clauses. Except as otherwise 
provided herein; all other clauses and terms & conditions of the RFP remain unchanged. 
 

S. 
No. 

Section/ Sub Section Relevant Clause  Modified/ Replaced Clause/ The clause to be read as  

1 Schedule of Events > 
Advertisement of RFP 
 
Page No. 2 

The RFP notice/ advertisement will be 
published in the following: 

a) e-Procurement Portal of IFSCA: 
https://ifsca.enivida.com/ 

b) Official Website of IFSCA: 
https://ifsca.gov.in/ 

c) 4 Indian National Newspapers 
 
The RFP will be published on the e-
Procurement Portal of IFSCA from 09 June 
2025 up till 1500 hours of 31st July 2025. 

The RFP notice/ advertisement will be published in the 
following: 

a) e-Procurement Portal of IFSCA: 
https://ifsca.enivida.com/ 

b) Official Website of IFSCA: 
https://ifsca.gov.in/ 

c) 4 Indian National Newspapers 
 
The RFP will be published on the e-Procurement Portal of 
IFSCA from 09 June 2025 up till 1500 hours IST of 11th August 
2025. 

2 Schedule of Events > 
Last date (deadline) for 
submission of bids 

31st July 2025 at 1500 hrs. 

The bids shall be uploaded in the format 
and mode as provided for in the e-

11th August 2025 at 1500 hrs IST. 

The bids shall be uploaded in the format and mode as 
provided for in the e-Procurement Portal for this RFP and shall 

https://ifsca.enivida.com/
https://ifsca.gov.in/
https://ifsca.enivida.com/
https://ifsca.gov.in/
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including EMD (on or 
before) 
 
Page No. 3 
 

Procurement Portal for this RFP and shall be 
digitally signed by the authorized signatory 
by the Solution Provider. 

The Solution Provider may make the EMD 
payment online via IFSCA’s e-Procurement 
portal. 

be digitally signed by the authorized signatory by the Solution 
Provider. 

The Solution Provider shall make the EMD payment online via 
IFSCA’s e-Procurement portal. 

3 Schedule of Events > 
Advertisement of RFP 
 
Page No. 3 

Date and time for opening of Pre-
qualification bids of the bidders. 
 
4th August 2025 at 1500 hrs. 

Date and time for opening of Pre-qualification bids of the 
bidders. 
 
12th August 2025 at 1500 hrs. 

4 4. Scope of Work > 
4.3.5.4 Security 
Requirements > Point 31 
 
Page No. 40 

Authentication methods supported shall 
be password, OTP, biometric 
authentication, key/token based. 

 Authentication methods supported shall be password, OTP, 
biometric authentication key/token based. 

5 4. Scope of Work > 
4.3.5.4 Security 
Requirements > Point 36 
 
Page No. 40-41 

Exception reports and alerts are sent on 
abnormal activity (volume, timing) to 
stakeholders - user, department officials, 
landowners, etc. 

Exception reports and alerts are sent on abnormal activity 
(volume, timing) to stakeholders - user, department officials, 
landowners, etc. 

6 4.5 Project 
Implementation Details 
> 4.5.1 Implementation 
Plan > Project Initiation > 
Deliverables 
 
Page No. 59 

• Implementation Team deployed at 
IFSCA premises or Delhi NCR (as per 
IFSCA requirements and decision). 

• Hosting & Dev Environment Plan 
• Software Licenses procured & 

commissioned 

• Implementation Team deployed at IFSCA premises or 
Delhi NCR (as per IFSCA requirements and decision). 

• Hosting & Dev Environment Plan 
• Software Licenses procured & commissioned 

7 6.1 Payment Schedules 
and Milestones- 
Implementation Phase 
 
Page No. 74 

The selected Solution Provider shall raise 
invoice on reaching an Implementation 
milestone. Each milestone needs to be 
signed off by IFSCA.  
 
.  

The selected Solution Provider shall raise invoice on reaching 
an Implementation/O&M milestone. Each milestone needs to 
be signed off by IFSCA. Payment shall be made by IFSCA 
within thirty (30) working days from the date of receipt of 
the invoice, provided that no objection or dispute has been 
raised with respect to the said invoice during that period.  



 3 

8 6. Payment Schedules 
and Milestones 
6.3 Penalties, Retentions 
and Liquidated Damages 
 
Page No 74 

3. Change in Resource Skillset or Role: If a 
resource of a certain skill set or role is 
required to be changed as per the project 
requirements, IFSCA reserves the right to 
ask the Solution Provider to replace the 
resources with a timeline of 15 days.  In 
case Solution Provider is unable to provide 
the resource at the deployment phase or 
replacement of any relieved resource 
within the specified time, the Solution 
Provider will be charged penalty as per 
Point No. 6 in this section. Solution Provider 
has to provide same resources for project 
implementation whose resume is shared, 
interviewed and shortlisted during bid 
submission. 

 3. Change in Resource Skillset or Role: If a resource of a 
certain skill set or role is required to be changed as per the 
project requirements, IFSCA reserves the right to ask the 
Solution Provider to replace the resources with a timeline of 
15 days.  In case Solution Provider is unable to provide the 
resource at the deployment phase or replacement of any 
relieved resource within the specified time, the Solution 
Provider will be charged penalty as per Point No. 6 in this 
section. The Steering committee may waive penalties in 
cases where the delay is attributable to reasons beyond 
the control of the Solution Provider, subject to due 
diligence and justification recorded in writing. Solution 
Provider has to provide same resources for project 
implementation whose resume is shared, interviewed and 
shortlisted during bid submission. 

9 RFP Section: 9.1.2 Pre-
Qualification Criteria > 
Point No III > 
Annual Turnover 
 
Page No. 88 
 
 
 
 
 
 
 
 
 
 
 
 

The Solution Provider should have had an 
average annual turnover of at least INR 70/- 
Crores (Rupees Seventy Crores only) in the 
last 3 Financial years* in Information 
Technology (IT) and IT enabled services 
(ITeS). 
 
(Reference: The Solution Provider shall 
submit proof of turnover for the FY 2024-25, 
2023-24 and FY 2022-23) 
 
*In case, the company/ LLP operates on 
calendar year, the audited statements will 
be required for calendar years 2022, 2023 
and 2024 
 
 
Documents Proof: 

The Solution Provider should have had an average annual 
turnover of at least INR 70/- Crores (Rupees Seventy Crores 
only) in the last 3 Financial years* in Information Technology 
(IT) and IT enabled services (ITeS). 
                                                                                    
(Reference: The Solution Provider shall submit proof of 
turnover for the FY 2024-25, 2023-24 and FY 2022-23) 
 
*In case, the company/ LLP operates on calendar year, the 
audited statements will be required for calendar years 2022, 
2023 and 2024 
 
Documents Proof: 
Audited financial statements of the company along with 
Profit & Loss Statements and Balance sheets for the said 
period. A certificate from the authorised signatory (viz. 
Company Secretary/ Statutory Auditor) clearly stating the 
turnover. 
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. 
 

Audited financial statements of the 
company along with Profit & Loss 
Statements and Balance sheets for the said 
period. A certificate from the authorised 
signatory (viz. Company Secretary/ 
Statutory Auditor) clearly stating the 
turnover. 

 
Note: Provisional certificate from statutory 
auditor/Chartered Accountant /Company Secretary with 
clearly mentioned Annual Turnover for calendar year/FY 
2024-25 only will be considered, only in case wherein 
audited financials is not finalized. The bidder shall be 
required to submit the audited financials once they are 
available. 

10 9.1.2 Pre-Qualification 
Criteria > Point No V > 
Positive Net Worth 
 
Page No. 89 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Solution Provider should have a 
positive net worth for the last 3 Financial 
years*, latest FY ending on 31st March 
2025. 
 
(Reference: The Solution Provider shall 
submit proof for the FY 2024-25, 2023-24 
and FY 2022-23). 
 
*In case, the company/ LLP operates on 
calendar year, the audited statements will 
be required for calendar years 2022, 2023 
and 2024. 
  
Documents Proof: 
Certificate from statutory auditor with 
clearly mentioned Net-Worth details. 

The Solution Provider should have a positive net worth for the 
last 3 Financial years*, latest FY ending on 31st March 2025. 
 
(Reference: The Solution Provider shall submit proof for the 
FY 2024-25, 2023-24 and FY 2022-23). 
 
*In case, the company/ LLP operates on calendar year, the 
audited statements will be required for calendar years 2022, 
2023 and 2024. 
  
Documents Proof: 
Certificate from statutory auditor with clearly mentioned 
Net-Worth details.  
 
Note: Provisional certificate from statutory 
auditor/Chartered Accountant /Company Secretary with 
clearly mentioned Net-Worth details for only calendar 
year/FY 2024-25 will be considered, only in case wherein 
audited financials is not finalized. The bidder shall be 
required to submit the audited financials once they are 
available. 
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11 9.1.2 Pre-Qualification 
Criteria > Point VII > 
Minimum Project 
Experience 
 
Page 89-90 
 
 
 
 
 
 
 
 
 
 
 

The Solution Provider must have 
successfully implemented (Go-live) either: 

a. at least two (02) software solutions/ 
projects, each with a minimum 
project value of INR 15 crore, or 

b. one (01) software solution/ project 
with a minimum project value of INR 
30 crore, 

for National Competent Authority (NCA) in 
India or abroad. 
 
Note: National Competent Authority (NCA) 
means Central Government/ Central 
Government Departments/ Central 
Government owned Organizations/ 
National Autonomous Bodies/ Financial 
Sector Regulators. 

The Solution Provider must have successfully implemented 
(Go-live) either: 

a. at least two (02) software solutions/ projects, each 
with a minimum project value of INR 15 crore, or 

b. one (01) software solution/ project with a minimum 
project value of INR 30 crore, 

for National Competent Authority (NCA) in India or abroad. 
 
Note: National Competent Authority (NCA) means Central 
Government/ Central Government Departments/ Central 
Government owned Organizations/ National Autonomous 
Bodies/ Central PSU/ Public Sector Banks/ Public Sector 
Insurance Companies/ Public Sector Financial 
Institutions/ CPSEs/ Financial Sector Regulators. 

12 9.1.2 Pre-Qualification 
Criteria > Point X >   
Other Requirements       
                                                                                                                                                       
Page No. 90 

Solution Provider should provide EMD as 
per the requirement of this RFP. 

Solution Provider should provide EMD as per the requirement 
of this RFP. 
 
MSMEs are exempted from submission of EMD. 
 
Micro and Small Enterprises (MSEs) as defined in MSE 
Procurement Policy issued by Department of Micro, Small 
and Medium Enterprises (MSMEs) or are registered with 
the Central Purchase Organization or the concerned 
Ministry or Department or Startups as recognized by 
Department of Industrial Policy & Promotion (DIPP) are 
exempted from submission of EMD. In such cases, an 
attested copy of the valid Registration Certificate from 
NSIC/ Recognition certificate of Startup must be 
furnished. Mere registration as SSI Unit or eligibility for 
startup does not qualify the Firm for exemption from 
furnishing the EMD. 
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Except MSMEs, If EMD is not submitted in accordance 
with the specified mentioned amount or is not in order 
otherwise, the submitted bid shall be summarily rejected. 
 
EMD must remain valid for at least 45 days beyond the 
final bid validity period and the validity of the EMD should 
be extended in the event the last date of bid validity is 
extended. 
 
The EMD of the successful Bidder will be discharged upon 
the successful Bidder signing the Contract with IFSCA. No 
interest is payable on EMD. 

13 9. Eligibility and 
Evaluation Criteria > 
9.2.2 Technical 
Evaluation Criteria > 
Table Point A 
 
Page No. 91-92 

Turnover of the Solution Provider 
 
The Bidder turnover in FY 2024-25 from IT 
and IT enabled services (ITeS). 
 
In case the company/ LLP operates on 
calendar year, the audited statements will 
be required for calendar year 2024. 
 
Note: For the purpose of this criterion, 
turnover includes application 
development/ implementation/ 
maintenance excluding equipment 
licensing and/or consulting. Also, turnover 
of only the bidding entity will be 
considered. The turnover of any parent, 
subsidiary, associated or other related 
entity will not be considered. 
 
Marks distribution: 
a. 70-150 Crores: 05 marks 

Turnover of the Solution Provider 
 
The Bidder turnover in FY 2024-25 from IT and IT  
enabled services (ITeS). 
 
In case the company/ LLP operates on calendar year, the 
audited statements will be required for calendar year 2024. 
 
Note: For the purpose of this criterion, turnover includes 
application development/ implementation/ maintenance 
excluding equipment licensing and/or consulting. Also, 
turnover of only the bidding entity will be considered. The 
turnover of any parent, subsidiary, associated or other 
related entity will not be considered. 
 
Marks distribution: 
a. 70-150 Crores 70 Crores and up to 150 Crores: 05 marks 
b. 01 incremental mark per 50 Crores turnover over and 
above 150 crores up to 05 marks. 
b. More than 150 Crores and up to 200 Crores: 06 marks 
c. More than 200 Crores and up to 250 Crores: 07 marks 



 7 

b. 01 incremental mark per 100 Crores 
turnover over and above 150 crores up to 
05 marks. 
 
Note: The Turnover should be in INR 

d. More than 250 Crores and up to 300 Crores: 08 marks 
e. More than 300 Crores and up to 350 Crores: 09 marks 
f.  More than 350 Crores: 10 marks 
 
Note: The Turnover should be in INR 

14 9. Eligibility and 
Evaluation Criteria > 
9.2.2 Technical 
Evaluation Criteria > 
Table Point A 
 
Page No. 91-92 
 
 
 
 
 
 

Turnover of the Solution Provider > Required 
Documents/ Evidence 
 
Audited financial statements of the 
company along with Profit & Loss 
Statements and Balance sheets for the said 
period. 
 
A certificate from the authorized signatory 
(viz. Company Secretary/ Statutory Auditor) 
clearly stating the turnover. 

Turnover of the Solution Provider > Required Documents/ 
Evidence 
 
Audited financial statements of the company along with Profit 
& Loss Statements and Balance sheets for the said period. 
 
A certificate from the authorized signatory (viz. Company 
Secretary/ Statutory Auditor) clearly stating the turnover. 
 
Note: Provisional financial statements for only calendar 
year/FY 2024-25 will be considered, only in case wherein 
audited financials is not finalized. The bidder shall be 
required to submit the audited financials once they are 
available. 
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15 9. Eligibility and 
Evaluation Criteria > 
9.2.2 Technical 
Evaluation Criteria > 
Table Point B  
 
Page No. 92 

Relevant Past Experience 
 
Bidder as SI covering implementation of 
Regulatory Reporting/ Regulatory Filing or 
similar SupTech/ RegTech solution (or 
project) implementation in BFSI sector/ 
National Competent Authority (NCA) in 
India or Globally in the last five (05) 
Financial years in India. 
 
For this requirement, bidder’s experience 
shall be in the execution of IT projects/ 
maintenance of IT projects and excluding 
consultancy services for the IT projects.         
 
 
                                                                                                                                                                                                                        
 
 
 
 
Note: National Competent Authority 
(NCA) means Central Govt./ Central Govt. 
Departments/ Central Govt. owned 
Organizations/ National Autonomous 
Bodies/ Financial Sector Regulators. 
 
 

Relevant Past Experience 
 
Bidder as System Integrator (SI) covering implementation or 
OEM providing solution of Regulatory Reporting/ Regulatory 
Filing or similar SupTech/ RegTech solution (or project) 
implementation in BFSI sector/ National Competent 
Authority (NCA) in India or Globally in the last five (05) 
Financial years in India. 
 
For this requirement, bidder’s experience shall be in the 
execution of IT projects/ maintenance of IT projects and 
excluding consultancy 
services for the IT projects. 
 
 
 
 
 
 
 
Note: National Competent Authority (NCA) means Central 
Government/ Central Government Departments/ Central 
Government owned Organizations/ National Autonomous 
Bodies/ Central PSU/ Public Sector Banks/ Public Sector 
Insurance Companies/ Public Sector Financial 
Institutions/ CPSEs/ Financial Sector Regulators. 
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16 9. Eligibility and 
Evaluation Criteria > 
9.2.2 Technical 
Evaluation Criteria > 
Table Point C 
 
Page No. 92-93 

NIC Cloud/ Meghraj Experience 
 
Bidder has hosted any Software/ IT project 
on NIC Data Centre or NIC Cloud or 
Meghraj/ Meghraj 2.0 Cloud. 
a. One project: 05 marks 
b. Two projects: 7.5 marks 
c. Three projects or above: 10 marks 

 NIC Cloud/ Meghraj Experience Experience in Cloud 
Hosting 
 
Bidder has hosted any Software/ IT project on NIC Data 
Centre or NIC Cloud or Meghraj/ Meghraj 2.0 Cloud/ MeitY 
Empanelled Cloud. 
a. One project: 06 marks 
b. Two projects: 08 marks 
c. Three projects or above: 10 marks 
 
Required Documents/ Evidence: 
Work Orders/ Completion Certificates, Project Citations 
and References. Certificate from company Secretory in 
case the work order is confidential. 
 

17 9. Eligibility and 
Evaluation Criteria > 
9.2.2 Technical 
Evaluation Criteria > 
Table Point D 
 
Page No. 93 

CMMI level and Certifications > Max Marks 
(20) 
 
Bidder has valid: 
a. CMMI level 
      a. CMMI Level 3: 05 marks 
      b. CMMI Level 4: 10 marks 
      c. CMMI Level 5: 15 marks 
b. ISO 27001:2015: 03 marks 
c. ISO 9000/ ISO 9001: 02 marks 

CMMI level and Certifications > Max Marks (15) 
 
Bidder has valid: 
a. CMMI level 
        a. CMMI Level 3: 06 marks 
        b. CMMI Level 4: 08 marks 
        c. CMMI Level 5: 10 marks 
b. ISO 27001:2015 or ISO 27001:2022: 03 marks 
c. ISO 9000/ ISO 9001: 02 marks 
 
Required Documents/ Evidence: 
CMMI level 3 or above, ISO certificate valid as on due date 
of submission of bid 

18 9. Eligibility and 
Evaluation Criteria > 
9.2.2 Technical 
Evaluation Criteria > 
Table Point 
 

New Text 9. Eligibility and Evaluation Criteria > 9.2.2 Technical 
Evaluation Criteria > Table > Point H 
 
Infrastructure Sizing, Scalability & Optimization Cost (derived 
from Annexure 3K) > Max Marks (05) 
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Page No. 94 Formula for Infra Related Marks = (Infra_Cost_Lowest/ 
Infra_Cost_Quoted) x 5 
 
Where: 

• Infra_Cost_Lowest = Lowest Financial Quote (as per 
Annexure 3K) for Infra sizing among all such bidders 
who will meet the Pre-Qualification (PQ) criteria. 

• Infra_Cost_Quoted = The Financial Quote of the 
bidder (as per Annexure 3K) for Infra sizing. 

19 9.3.3 Commercial 
Pricing Format > Table A 
– Project Implementation 
Manpower Count and 
Cost: 
 
Page No. 95-96 

Relevant Clause 
 
Table A – Project Implementation Manpower Count and Cost: 
 

S. No. Role 

Msn-Day 
Rate (INR) Man-

Month 
Rate (INR) 

Minimum 
Manpower 
Count 

Proposed 
Manpower 
Count 

Total Cost 
based on 
Proposed 
count 
(INR) 

1 Project Manager   1     

2 

Subject MaEer Expert(s) 
• Banking & Finance – 1 
• Insurance – 1 
• Capital Markets and 

Funds - 1 

  

3 

    
3 Implementa)on Team        
3.1 SoluNon Architect   1     
3.2 Senior Business Analyst   2     
3.3 Other Business Analyst   2   

3.4 Product Manager / Tech 
Lead 

  1     
3.5 Full Stack Developer   4     
3.6 Cloud Infra Ops   2     
3.7 DBA   2     
3.8 DevOps   1     
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3.9 InformaNon Security Expert   1     
3.10 UX Designer    1     
3.11 UI/UX Developer   1     
3.12 Tester   3     
3.13 Data Analyst   1     
3.14 Data MigraNon Consultant    1   
3.15 Content Writer   1   
3.16 Video Editor   1   
 Total   29     

Total Cost (INR)   To be filled in line-item 1 of Sec:on 
9.3.3 

 
Modified / Replaced Clause / The clause to be read as: 
 
Table A – Project Implementation Manpower Count and Cost: 
 

S. 
No. Role 

Man-
Day 
Rate (in 
INR 
without 
GST) 

Man-
Month 
Rate (in 
INR 
without 
GST) 

Minimum 
Manpower 
Count 

Minimum 
Onsite 
Manpower 
Count  

Minimum 
Offsite 
Manpower 
Count 

Proposed 
Manpower 
Count 

Total Cost 
based on 
Proposed 
count (in INR 
without GST) 

1 Project Manager   1 1 0     

2 

Subject MaEer 
Expert(s) 
• Banking & 

Finance – 1 
• Insurance – 

1 
• Capital 

Markets 
and Funds - 
1 

  

3 

3 0 
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3 Implementa)on 
Team 

     
    

3.1 SoluNon 
Architect 

  1 1 0 
    

3.2 Senior Business 
Analyst 

  2 2 0 
    

3.3 Other Business 
Analyst 

  2 1 1 
  

3.4 
Product 
Manager / Tech 
Lead 

  1 1 0 

    

3.5 Full Stack 
Developer 

  4 2 2 
    

3.6 Cloud Infra Ops 
  2 2 0 

    

3.7 DBA 
  2 2 0 

    

3.8 DevOps 
  1 1 0 

    

3.9 InformaNon 
Security Expert 

  1 1 0 
    

3.10 UX Designer  
  1 1 0 

    

3.11 UI/UX 
Developer 

  1 0 1 
    

3.12 Tester 
  3 3 0 

    

3.13 Data Analyst 
  1 1 0 

    

3.14 Data MigraNon 
Consultant  

  1 1 0 
  

3.15 Content Writer 
  1 0 1 

  

3.16 Video Editor 
  1 0 1 

  



 13 

 Total 
  29 23 6 

    
Total Cost (in INR 
without GST) 

To be filled in line-item 1 of Sec:on 9.3.3 

 
Note: Onsite location will be IFSCA premises in GIFT City, Gandhinagar, Gujarat. 
 

 

20 9.3.3 Commercial 
Pricing Format >Table B 
O&M Manpower Cost 
 
Page No. 96-97 

Relevant Clause. 
 
Table B - O&M Manpower Cost 
 

Sr. 
No. Role 

Man-
Day 
Rate 
(INR) 

Man-
Month 
Rate 
(INR) 

Minimum 
Manpower 
Count 

Y2  Y3  Y4  Y5  Y6  

1 Subject MaEer 
Expert 

 

  1           

2 Business Analyst    2           

3 Full stack 
Developer 

 
  2           

4 Database 
Administrator 

 
  1           

5 DevOps Engineer     1           
6 Tester    1           
7 Cloud Infra Ops    2           
8 Helpdesk Support    2           

Total 12           

Total Cost (INR)  To be filled in line-item 2 of 
Sec:on 9.3.3 

 
Modified / Replaced Clause / The clause to be read as : 
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Table B - O&M Manpower Cost 
 

Sr. 
No. Role 

Man-
Day 
Rate (in 
INR 
without 
GST) 

Man-
Month 
Rate (in 
INR 
without 
GST) 

Minimum 
Manpower 
Count 

Proposed 
Manpower 
Count 

Y2 
(Cost in 
INR 
without 
GST) 

Y3 
(Cost in 
INR 
without 
GST) 

Y4 
(Cost in 
INR 
without 
GST) 

Y5 
(Cost in 
INR 
without 
GST) 

Y6 
(Cost in 
INR 
without 
GST) 

1 Project 
Manager 

 

  1 

 

          

2 Business 
Analyst 

   2  
          

3 Full stack 
Developer 

 
  4  

          

4 Database 
Administrator 

 
  1  

          

5 Cloud Infra 
Ops 

   2  
          

6 Helpdesk 
Support 

   2            

Total 12            

Total Cost (in INR without GST)   To be filled in line-item 2 of Sec:on 9.3.3 
 
Note: The minimum O&M manpower support specified above needs to be onsite. Onsite location will be IFSCA 
premises in GIFT City, Gandhinagar, Gujarat. 
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21 9.3.3 Commercial 
Pricing Format > Table B 
- O&M Manpower Cost  
 
Page No. 97 

Above mentioned cost should cover entire 
project duration of 18 months of 
Implementation, 6 months of Warranty cum 
stabilization period and 5 years of O&M 
support. Post implementation of the 
Project, the next 6 months will be warranty 
period in which Solution Provider has to 
make all type of changes as per project 
deliverable scope without any additional 
cost. The location for the project team will 
be either at GIFT City, Gandhinagar, or Delhi 
NCR or as per mutually agreed between 
IFSCA, PMU and Solution Provider 

Above mentioned cost should cover entire project duration of 
18 months of Implementation, 6 months of Warranty cum 
stabilization period and 5 years of O&M support. Post 
implementation of the Project, the next 6 months will be 
warranty period in which Solution Provider has to make all 
type of changes as per project deliverable scope without any 
additional cost. The location for the project team will be either 
at GIFT City, Gandhinagar, or Delhi NCR or as per mutually 
agreed between IFSCA, PMU and Solution Provider. 

22 9.3.3 Commercial 
Pricing Format > 
Correction of Errors > 
Please note 
 
Page No. 97 

e. All costs incurred for delay in 
deliverables due to any reason, shall be 
borne by the Solution Provider. 
 

e. All costs incurred for delay in deliverables due to any 
reason attributable to the Solution Provider shall be borne 
by the Solution Provider. 

23 12.4 Performance Bank 
Guarantee (PBG) 
 
Page No. 116 
 

4. In the event of the Solution Provider being 
unable to perform the contract, IFSCA shall 
have the right to invoke the PBG at its sole 
discretion. However, pay-out of the PBG 
shall be without prejudice to the rights of 
IFSCA to seek remedy under any rights 
created under the agreement or in law or to 
seek specific performance of any of the 
terms of the Master Service Agreement. 
 

4. In the event of the Solution Provider being unable to perform 
the contract due to any reason attributable to the Solution 
Provider, IFSCA shall have the right to invoke the PBG at its 
sole discretion. However, pay-out of the PBG shall be without 
prejudice to the rights of IFSCA to seek remedy under any 
rights created under the agreement or in law or to seek 
specific performance of any of the terms of the Master Service 
Agreement. 
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24 12.4 Performance Bank 
Guarantee (PBG) 
 
Page No. 116 
 

5. In case any claims or any other contract 
obligations are outstanding, the successful 
Solution Provider shall extend the validity 
period of the PBG as asked by IFSCA till 
such time the successful Solution Provider 
settles all claims and completes all 
contract obligations. 

5. In case any claims or any other contract obligations are 
outstanding due to default or breach of SP, the successful 
Solution Provider shall extend the validity period of the PBG as 
asked by IFSCA till such time the successful Solution Provider 
settles all claims and completes all contract obligations. 

25 12.4 Performance Bank 
Guarantee (PBG) 
 
Page No. 116 
 

6.IFSCA shall also be entitled to make 
recoveries from the bidder’s bills, PBG, or 
from any other amount due to them, the 
equivalent value of any payment made to 
them due to inadvertence, error, collusion, 
misconstruction, or misstatement. 

6.IFSCA shall also be entitled to make recoveries from the 
bidder’s bills, PBG, or from any other amount due to them, the 
equivalent value of any payment made to them due to 
inadvertence, error, collusion, misconstruction, or 
misstatement arising out of this Agreement. 

26 12.7 Suggestions on the 
Draft Master Service 
Agreement 
 
Page No. 117 

1. A Master Service Agreement (MSA) 
including the standard terms and all the 
other terms specific to the implementation 
of the Project is enclosed as Annexure I in 
Part C of this RFP. IFSCA reserves the right 
to revise this contract. 

1. A Master Service Agreement (MSA) including the standard 
terms and all the other terms specific to the implementation 
of the Project is enclosed as Annexure I in Part C of this RFP. 
IFSCA reserves the right to revise this contract. 

27 Appendix I, Appendix II       
 
Page No. 118-135 
 
 
 
 
 

Appendix I: Functional Fitment Matrix for 
COTS/ MOTS/ Hybrid solution 
 
Appendix II: Functional Fitment Matrix for 
Be-Spoke solution 
 

Bidder needs to fill either Appendix I or Appendix II as per 
applicability. 

Appendix I: Functional Fitment Matrix for COTS/ MOTS/ 
Hybrid solution 
 
OR 

Appendix II: Functional Fitment Matrix for Be-Spoke solution 
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28 Annexure 1 > MASTER 
SERVICE AGREEMENT 
 
Page No. 143-144  
 
 
 
 
 

2.4 Extension of the Agreement 
 
IFSCA shall have the sole option to extend 
the Term by a duration decided by IFSCA 
and upon expiry thereof, to avail the 
services of SP for specific work or 
continuation of the work carried out during 
the Term without a separate bid process. 
 
All the terms and conditions of this 
Agreement will be in force during the 
extended period of the Agreement. 

2.4 Extension of the Agreement 
 
IFSCA shall have the sole option Both of the parties with 
mutual consent shall have the option to extend the Term by 
a duration decided by IFSCA and upon expiry thereof, to avail 
the services of SP for specific work or continuation of the 
work carried out during the Term without a separate bid 
process. 
 
All the terms and conditions of this Agreement will be in 
force during the extended period of the Agreement. 

29 Annexure 1> MASTER 
SERVICE AGREEMENT > 
5. Payment Terms 
 
Page No. 148  

5.1 Performance Bank Guarantee  
 
A Performance Bank Guarantee (“PBG”) of 
10% of value of the Agreement shall be 
furnished by the SP, as per the format 
provided in the RFP, from Scheduled Indian 
Banks. The PBG should be furnished within 
30 working days from the issue of the Letter 
of Intent and shall be valid up to 180 days 
beyond the Term or any extension thereof. 
 
In case any claims or any other contractual 
obligations are outstanding, the SP shall 
extend the PBG as directed by the IFSCA till 
such time the SP settles all claims and 
completes all contract obligations. The 
PBG shall be subject to encashment by the 
IFSCA, in case conditions regarding 
adherence to delivery schedule, conditions 
regarding warranty, settlement of claims, 
and other provisions of this Agreement are 
not fulfilled by the SP.  

5.1 Performance Bank Guarantee  
 
A Performance Bank Guarantee (“PBG”) of 10% of value of the 
Agreement shall be furnished by the SP, as per the format 
provided in the RFP, from Scheduled Indian Banks. The PBG 
should be furnished within 30 working days from the issue of 
the Letter of Intent and shall be valid up to 180 days beyond 
the Term or any extension thereof. 
 
In case any claims or any other contractual obligations are 
outstanding due to default or breach of SP, the SP shall 
extend the PBG as directed by the IFSCA till such time the SP 
settles all claims and completes all contract obligations. The 
PBG shall be subject to encashment by the IFSCA, in case 
conditions regarding adherence to delivery schedule, 
conditions regarding warranty, settlement of claims, and 
other provisions of this Agreement are not fulfilled by the SP.   
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30 Annexure I > MASTER 
SERVICE AGREEMENT > 
14. Intellectual Property 
Rights 
 
Page No. 164  
 

14.1 Products and Fixes 
 
Except to the extent otherwise expressly 
provided in this Agreement, the IFSCA shall 
exclusively retain all rights, titles and 
interests in the trademarks, patents, 
copyrights, trade secrets, operating 
practices/ procedures or other Intellectual 
Property Rights (“Intellectual Property 
Rights/IPR”) relating to the Assets and 
related Solutions, including but not limited 
to, portal Application, portal infrastructure, 
database, forms and the compilations any 
computer code, web-based services, or 
materials comprising commercially 
released, pre-release or beta products 
(whether licensed for a fee or no charge) 
and any derivatives of the foregoing to 
which the IFSCA has sovereign rights and 
nothing herein shall or will be construed or 
deemed to grant to the SP any right, title, 
license, sub-license, proprietary right or 
other claim against or interest in, to or 
under (whether by estoppels, by 
implication or otherwise) to the aforesaid 
rights. 

14.1 Products and Fixes 
 
Except to the extent otherwise expressly provided in this 
Agreement, the IFSCA shall exclusively retain all rights, titles 
and interests in the trademarks, patents, copyrights, trade 
secrets, operating practices/ procedures or other Intellectual 
Property Rights (“Intellectual Property Rights/IPR”) relating to 
the IFSCA Assets and related Solutions, including but not 
limited to, portal Application, portal infrastructure, database, 
forms and the compilations any computer code, web-based 
services, or materials comprising commercially released, pre-
release or beta products (whether licensed for a fee or no 
charge) and any derivatives of the foregoing to which the 
IFSCA has sovereign rights and nothing herein shall or will be 
construed or deemed to grant to the SP any right, title, license, 
sub-license, proprietary right or other claim against or interest 
in, to or under (whether by estoppels, by implication or 
otherwise) to the aforesaid rights. 

31 Annexure I > MASTER 
SERVICE AGREEMENT > 
SCHEDULE IV: Non-
Disclosure Agreement > 
4. OBLIGATIONS OF THE 
RECEIVING PARTY 
 
Page No. 205 

g. upon the Disclosing Party's request, the 
Receiving Party shall either return to the 
disclosing party all Confidential Information 
or shall certify to the disclosing party that all 
media containing Confidential Information 
have been destroyed. Provided, however, 
that an archival copy of the Confidential 
Information may be retained in the files of 

g. upon the Disclosing Party's request, the Receiving Party 
shall either return to the disclosing party all Confidential 
Information or shall certify to the disclosing party that all 
media containing Confidential Information have been 
destroyed. Provided, however, that an archival copy of the 
Confidential Information may be retained in the files of the 
Receiving Party's counsel, solely for the purpose of proving the 
contents of the Confidential Information or where it is 
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the Receiving Party's counsel, solely for the 
purpose of proving the contents of the 
Confidential Information. 

necessary to retain any Confidential Information for the 
purpose as required by law. 
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32 

Annexure 
3K > Infra 
Sizing 
 
Page No. 
245-246 
 

Relevant Clause 
 
Annexure 3K: 
 
Complete the infrastructure sizing template below with all relevant details. 

1. Use the MeghRaj 2.0 Cloud Infrastructure Cost Calculator (refer PaaS) to estimate the cloud costs. Link to the 
cost calculator: https://ngc.gov.in/cost-calculator 

2. Ensure all sizing estimates account for peak loads, redundancy, and high availability requirements as per this 
RFP. 

3. Provide justifications for each component and ensure compliance with government security and performance 
guidelines. 

4. Share proposed complete Tech stack for DRR solution. 
 
Infrastructure Sizing Template (Indicative) use Platform as a Service (PaaS): 

S. 
No 

Archite
cture 
Layer 

Compo
nent/ 
Product 

Enviro
nment 

Insta
nce 
Coun
t 

Quan
tity 

vCPU
s 
(each 
insta
nce) 

Mem
ory 
(each 
insta
nce) 
(GB) 

Di
sk 
(G
B) 

Justific
ation 

Estim
ated 
Cost 
(Megh
raj 2 
Calcul
ator) 

                    
                    
                    
                    

 
Assumptions & Justifications 

• Clearly state all assumptions related to scalability, redundancy, and load balancing. 
• Justify the need for each infrastructure component based on system design and expected usage. 
• Indicate any reserved capacity for future scaling. 

 
Summary of MeghRaj 2.0 Platform as a Service (PaaS) Infrastructure Cost Estimates as below:  
 
 

https://ngc.gov.in/cost-calculator
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This cost will be borne by IFSCA and not part of TCO/ BOM, Share details as below for Infra sizing  cost estimation: 
 

Phase Total Estimated Cost 
(₹) 

A. Year 1(Project implementation Phase) including Warranty 
Period 

₹XXXX 

B. Year 2-6 ₹XXXX 

Grand Total (A+B) ₹XXXX 

Note: Please provide year-wise breakdown separately. 
 
Compliance & Security Requirements 

• Solution Provider must ensure all infrastructure components comply with government security standards. 
• The System must adhere to Cert-In security guidelines. 
• Disaster recovery and data backup strategies must be clearly outlined. 

 
Declaration and Certification 
 
We certify that the above infrastructure estimates have been computed using the MeghRaj 2 Cloud Calculator and are 
aligned with the performance and security requirements stipulated in this RFP and we agree to its inclusion in the 
evaluation of our submission. 
 
Authorized Signatory: 
Name: ________________ 
Designation: ________________ 
Company: ________________ 
Date: ________________ 
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Modified / Replaced Clause / The clause to be read as  
 
Annexure 3K: 
 

A. Infrastructure Sizing Template: 
 
The Bidder shall fill in the Sizing Format provided below and submit the details, considering the following: 
 
1. Use the MeghRaj 2.0 Cloud Infrastructure Cost Calculator (refer PaaS/ IaaS in Service Type as per available 

option in private cloud otering) to estimate the total infra sizing cloud costs. Link to the cost calculator: 
https://ngc.gov.in/cost-calculator 

2. SP must select “Private Cloud” under the “Cloud Otering” category while using the calculator. 
3. Ensure all sizing estimates account for peak loads, redundancy, and high availability requirements as per 

this RFP. 
4. Provide justifications for each Component/ Product and ensure compliance with government security and 

performance guidelines. 
5. Share proposed complete Tech stack for DRR solution. 
6. The cost of all service and product categories, as required by the technological architecture of the proposed 

DRR Solution, should be included in the sizing cost by the Solution Provider using the Meghraj 2.0 
calculator. Examples include Compute, Container, Storage, and Database services. If a required database/ 
any other service (or tool) is required for the functioning of the proposed DRR Solution and is not available 
under Meghraj 2.0 platform, it must be provisioned separately and included in the commercial bid of the 
bidder under ‘Cost of software tools’, if applicable. 

 
Note: All requirements related to Backup Services, Security Services such as Vulnerability Assessment (VA), 
Antivirus (AV), Application Load Balancer with Web Application Firewall (WAF), SSL Certificate, Hardware 
Security Module (HSM), Next-Generation Firewall, and Security Information and Event Management (SIEM) with 
500 EPS capacity will be provisioned by IFSCA post-finalization of the tender, in consultation with the 
Solution Provider (SP). However, the Solution Provider (SP) shall be responsible for provisioning application-
level, data-level, information-level, and solution-level security, including integration with the existing security 
solutions at IFSCA. 

 

https://ngc.gov.in/cost-calculator
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Note: The above table is indicative for sizing purposes. The Solution Provider (SP) may add additional columns and 
rows to facilitate a more detailed understanding during evaluation at IFSCA's end. The sizing details provided as 
above will be shared with the NIC team for provisioning of infrastructure. Wherever applicable, please select the 
maximum duration in the calculator to arrive at the most cost-etective billing estimate. 

 
B. Environments: 
 

• All the four (04) environments (QA, UAT/Pre-Prod, Production and DR) need to be considered while 
filling the above details whose cost will be borne by IFSCA. 
 

• Furthermore, the QA and UAT/Pre-Production environments should be provisioned at 50% of the 
Production environment size, while the Disaster Recovery (DR) environment should be a near-exact 
replica of the Production environment. 
 

• The Solution Provider shall be responsible for the provisioning, configuration, and maintenance of 
the Development and System Integration Testing (SIT) environments at its own premises and within 
its own infrastructure. All associated costs - including but not limited to infrastructure, licensing, 
personnel, and support services - for the setup and ongoing operation of these environments shall be 
borne solely by the Solution Provider. IFSCA shall have no financial liability in this regard. 

 
 



 24 

C. Assumptions & Justifications: 
 

1. Clearly state all assumptions related to scalability, redundancy, and load balancing. 
2. Justify the need for each infrastructure component based on system design and expected usage. 
3. Indicate any reserved capacity for future scaling. 

 
D. NGC/ NIC Meghraj 2.0 - Infrastructure Sizing Cost: 

 
Infrastructure Sizing, Scalability & Optimization Cost (as per the format mentioned below) will be borne by 
IFSCA and is not part of the TCO/BOM of the Solution Provider. The details are to be shared for 
infrastructure sizing cost estimation. 

 
Five (5) marks have been allocated for ‘Infrastructure Sizing, Scalability & Optimization Cost’ under Section 
9.2.2 Technical Evaluation Criteria > Table > Point H. 

 
As part of the Technical Evaluation Framework: 

 
Formula for Infra Related Marks = (Infra_Cost_Lowest/ Infra_Cost_Quoted) x 5 

 
Where: 

• Infra_Cost_Lowest = Lowest Financial Quote (as per Annexure 3K) for Infra sizing among all such bidders who 
will meet the Pre-QualificaUon (PQ) criteria. 

• Infra_Cost_Quoted = The Financial Quote of the bidder (as per Annexure 3K) for Infra sizing. 
 

NGC/ NIC Meghraj 2.0 Infrastructure Cost Format: 
 

Bidders are required to submit this as part of their Technical Bid response. 
 

Phase Total Estimated Cost (in INR) 
A. Year 1 (Project implementation Phase of 18 
months) and 6 months Warranty Period. 

₹XXXX 

B. Year 2-6 (5 years of O&M Phase) ₹XXXX 
Grand Total (A+B) – in INR ₹XXXX 
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Note: 
• Please provide year-wise/ periodic breakdown separately. 
• Year 2 will start after the completion of 18 months of Project Implementation and 6 months of 

warranty period (24 Months). 
 

E. Compliance & Security Requirements: 
 

1. Solution Provider must ensure all infrastructure components comply with government security 
standards. 

2. The System must adhere to Cert-In security guidelines. 
3. Disaster recovery and data backup strategies must be clearly outlined. 

 
F. Bidders are required to submit the following duly filled and signed declaration as part of their Technical Bid 

response. 

Declaration and Certification: 
 

We hereby certify that the infrastructure estimates (submitted as part of the Technical Bid) have been computed 
using the MeghRaj 2.0 Cloud Calculator and are aligned with the optimal solution performance and security 
requirements stipulated in this RFP. We agree to their inclusion in the evaluation of our submission. 
 
Sign and Stamp of the Authorized Signatory of the Bidder: 
 
 
Name: ________________ 
Designation: ________________ 
Company: ________________ 
Date: ________________ 

 
     

Sd/-  
General Manager-IT (IFSCA) 

21 July 2025 


